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& A ORIERARRIBERE T TRV EEL Thbhv i, BIEOEAFICONTIE, 25—V %
ZRLTIEEN,

T 7T e ALV OMEZERT 272012, 1FEIC T EHOKEZFETL TIEI,
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AR RERIE

B REE R RE

ARSI TR B R 2 5D . SO NIREN T =X S ET, WERELZRETS L. kOB
EMEITSINET,

n EESPNEEREA L EVWVEEZEZ D LEE Xy v —URERRENET,
n EBROEENEHICEFT L L ARSETABNICY vy MU LET,

BIEX b —URERENTEZDS, ROFMHEZF = 7 L TLIEEW, BMEDOBEEIZHWVL T,
2R—=TESHL TLEEN,

n ERVPTEOIREHHCHEH SN TV D,
B FTEDHRESRME (VT T R) ZiiEL TV 5D,
m RO T7 U NELLEEL TWAS

HAaRo4

AMEERORTHARZNMNL, FERHIIAOax 7 2 ATz ZBAESNTWET, E5H
JTIH =z 7 2R DIE S E M 72N TL7E &0,

og Mkr 1 Mkr 2 Analog Analog Mkr 1 Mkr 2 Analog Analog Mkr Mkr 2 Analog Event

666606606060660606060 6.6

DO NOT APPLY EXTERNAL SIGNAL <5VRMS

BEEMA BTSN,
BYET,

EE BEHNax 7 2y —T NV EERERIIRATEHEAIT. Y THEBEREERL —ZDES
x4 7120 TLEEW, BEEHANA v OIRRE TR (DUT) 289 5 & A
DUT IZHEEZ 52252 03B £,
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FREEIEERL —Z TlE, 2HBEOFT T A2 « ~VTHRHESNTVET,
B 2= e F T A ST R OT N T ORI T 2R MERE SR T £,

B TS Sv Ty e~ T UE—R s awr RICET AT SIS ERL AT A
Vo~V O TR SN ET,

NIVT VAT NIT VAT DI <:)
1T, A==— 3=/, Help % i ‘elp
WL £,
1. 2—H% - FrIA4r - ~VTIZT

7 EAT 5121, Help Topic... & Help on Remote Commands...

@
&*R L& ﬁ_o @ Specifications...
@

Help Topic...
Help on Window... F1

2. BIIEOEIED 0 R UICBET 50k
WIS T2~V (2T XA B
BAF~NVT) ZFIHT DI,
Help on Window... Z &R 7 570>,
FIFFL X —%2ML £,

3. Tur g~ AT A T
(27 7B A4 21213, Help on
Remote Commands... 2 2R L £
R

4, R ENRT F—~ o ARGEFIAE
HHL7ZPDE~v=a T LTV
& 29 %213 Specifications... %
EIRL £,

5. IZLAEDEAT R Ry T A
(ZiZ. Help 7R Z B3O TV E
. KA EIY I, B o
fERRINTWEHE AT T -

RNy 7 AZET o~ NT HFIRL {ICh1 -5 Ch2

E AN
[ Ok ll LCancel ][ Help } 0

Goupline

e~k

B 2P F T A ALTTRRENDIFHE L CRBELIIARBLRIRCTEET, 774
JU T, EEENIBRINTWET, SEE2ALE T 5I2iE, System A == —7)>5 Preferences...
ZBINL 9, 69 X—T 2L TLEEN,

EHARES T A - ~VT 2D T &, Language pack # A > AR — LT 5720DX AT 1
7 e Ry 7 ANRERSIET, Install 7 Y > 7 L T Japanese Language pack % A A h—/L L T
<IEENWY,

B I ar I T A s SV TIFIEFERIRORTT,
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BIE/ R JL

WOXKIL, AWG5014 RO RFiE /S Fx V&R L TWET,

AWG 5014 Arbitrary Waveform Gi

BIE/ AR ORI E

AR AR B
1. Ch 1 Analog Output TrhursEEEH AL £,
2%y« X A7 BNC
2. Ch 1 Marker Output ~—HEFEHDLET,
ax B« X A7 :BNC
3. Ch2~Ch4axxo# Ch2~Ch4 7 Fruar/7BLOl~—bEEH a7 X TY,
4. Trigger Input SR U TEFEANTEET,
ax g4 - A7 BNC
5. Event Input AR MEBEASTEET,
%K - X A7 BNC
6. USB 2050 USB T /NA A&t Cx 7,
7. DC Output 450 DCEEEZHNILET,

IFRTH A AT 254mm2x4E L Ny (AR)

B EeHhax s 2 —T7 Va2 £ AT EAIT. Y TEEREERL —2DE S
HAzEA 7120 TLEEW, FEHAnA »r OIRRE TR (DUT) 248564 5 &, AR

DUT ICHEA G252 &0RHV £,
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BE/ARI- ARV A

aARI 4R B
1. 10 MHz Reference Output IOMHz V 7 7L v R - 7y J{EBHhiaxr
axy K« 2147 :BNC
2. Reference Clock Input NEY 77 LR a2 AHHaxs %
ax & - X A7 BNC
3. Oscillator Output FL—FHhHax s &
axy &« %47 :BNC
4. External Clock Input FL—X AR T
ax & - X A7 BNC
5. Add Input AEEZR O INE F IHMNBE T 2L £7,
ax B« X247 BNC
6. GPIB GPIB a2 x 7 2 &ML THERE GPIB 2> b u—J 28k L £,
7. LAN RI-45 a3 7 Z &L T2 Ry U — 27 IZ8HE L 7,
8. Parallel Port /XZ L)L« AR— b (Centronics) (X, 7'V v ZMODT /S A 2 &z L
£
9. USB USB 7 /31 A& #fi L £7,
10. Video BT e R— NI, T=FOBICHETL £,
11. COM1 COMI > U 7 b« dR— b iE, Loz U 7L « BR— bkl T
e HEXIERL £,
12. PS-2 PS-2 F—AR— RN~ U R &t T 5 DITFEML £,
13. HDD B v 4L wHEZ: HDD T,
14. Digital Data Out TUHN e T2 MO ax s 2 TF, AWG5002 Opt. 03 £721%
AWG5012 Opt. 03 ZF5ET 2 LA FREIC/R D £,
ax X - XA7 :SMB

15, Z0aRx 7 XTI R —K INTWHEREA,
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m ) i m By | RVAY SV

WO, 4 F v RV« TTILORIE/ ARV « a2 b a— L Of T,

Run R &>
Open Save
w W
‘m Factory Default
: HRIRF—
All Outputs CAUTION Sampling Rate
(ouom) BN (@)
PERY ——
i Offset F
Channel Output On T (o - G @ W
Ray E
D
T ) w @ @ @
nghMarkeer A B c
L - w W w w W

Channel Select
RaE

Touch
Screen

Force
Trigger

@ @ e @

Force

Event |

3

.
HDD loc

O O

DC
Output
(]

Run. Run 7R % 3ME B RAEBEORM /1E1kEzay ba— L LET, BFEBRBEL TVD L XX
LED 8 5UT L £d, EBRICH a2 27 20 6E 542 M S8 512iE, A/ S1/L @ All Outputs

On/Off 7R # >, F 721 Channel Output On R ¥ > 2L CTH I Z A X —T NWIZTHRHERH Y £,

Touch Screen Off. % v F 2 7 J — U HERENA L DIRFED L & FEIERCARF A TR « RULEFERL
TRV = o A BT z2—REa s —)LTCEET, XvF « ATV —0NFT7DE X, LED
DIEAT L F9,

File Open/Save. Open £721% Save R ¥ U N END & KT HX AT RT « Ry 7 ANRKRS
. BET 7 AN (FAWG) & 0 — K £ RN T E ET,

Factory Default. = DR & v 2§ LIEEINTZT 7 4V hREVBMOHEINET, 77 4L FRE
WZOWTHE, 32 RX—U AL TSN,

Timing — Sampling Rate. = ® 7R % > % #f4- & Settings 7 « > K 7 T Timing X—Y OH 7V 7 -
L= DI A= REIRENET, T T V7 - L—MIEZT v XUICIETY, Settings
U4 Y RUIZOWTIE, 26 X—VEZHL TIZEN,

Channel Select. & v > F/VEIRA Z 2 13, BIEORIR L2 5F v o XNV ERIRTHOIHEAL £
T, BIE /S FNLDOT ¥ > FOVRINAR X B3 En b &, Settings 7 4 > KU OxIST 5T v Rb
DR—=UNT 7T 472780 £7,
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Channel Qutput On. 7 v > XV 1D v | A7 200 B2 £3, HARA L OREED & & LED 28
SUTL ET,

é EE Al S 2V OE S a3 7 ZISA S (DUT) 2866t d 5 & S 1d, BT AR ORE )
EAZICLTLSEENY,

AR OEFH IR A > ORETIE, ISR OEIRA Y | 47 2 {T7bRnT<Ean

All Outputs On/Off. & DL LD N NRA L DL ZIZZDORZ 2T &, TXTOHNMRA 7127
DEFT, TRXTOHNIPA 7D LEXNZZIORZ L EMT L TXTOHNNRA TR 5,

Amplitude. = DR & o ZH#3 & Settings 7 4 > KU Ti%M4 95T v %/ D Amplitude D/3T7 A —
ZPRINSNET, RIBIIET v o XAV THEINICRETE ET,

Offset. Z DA Z L 243 & Settings 7 4 > R U Ta%X 7T 5F ¥ K/ Offset D/3T A—Z 3R
SNET, A7y MIZFTF ¥ RV THEINICRETE ET,

Marker 1 & & TF Marker 2 - High/Low. = ® &R # o % #i4~ & Settings 7 ¢ > K 7 T34 5 F ¥ o %
Jb® Marker High %7213 Marker Low D/3 7 X —Z 23R E £ 4, Marker High & Marker Low [%
BHF ¥ AN THEBNCRETE £,

Force Trigger. Z DA Z &4 &, WEH NV TEEEZHIL E7,

Force Event. ZDR # v a3 & WA~V MEFEZH L E7,

MNA/7 .07, BEBEHBESELY, Ry FT o7 e Ama— TAFTL « A=a—,
FEFFATRT Ry VATT AT LERIRT 20 ENET, /7 &2KEHEI Y (BT & fH
WHEINL . RERHE 0 (2 [E] & fEAS D L E T,

HOBIR T — HORINERX—1L, E7 4 — LV R CHRFALET L XOMBIICERAL £, &
FEEHTAHICT ) T AMAL T,

BUEA A ¥ — . Bl A% (CHALHEEEERE X — (T/p. G/n. M/p. k/m) %49 L. Enter % —% #f
TR EHETE £,

BEREOGAEILT (77). G (), M (AH), k (Fn) LRINES, FRIOEGAITp (F
a).n (F /). p(zA47m), m (V) LRINET,

14 AWG5000 > 1) —X 94wy + RA—bk - 2—H - 3=a7)L



J kB—JL - /ARl

BIE/ARJ)L- avbkO—)Loay 4y 0y Y@k

EERIEE 2L — % O/ %X, GPIB = Ethernet TV E— MEESNTWAHIcE Yy 7 &N
HENHY ET, BIEARZANRE Yy 7SN TS EERAAL v FE2HRLTRATOF—RZ 0
EHTERLS RV ET, vURARF—A—NLEATEERA, 7L, Aim SR e y 75RK5EE
Tt Windows OEEIXAIRE T,

i/ S s avybo—rooy 7 2EERTHI12%, VEeE—b « a<r FE2ERT230. 720300
/XD Cancel R X % 2\ CTHLET, 77V r—ra 28735 &0y ZIREIXfERR
SNFET, FOT TV r—va 2R L7254, s/ Scuviiny ZJHEI TV ET,

AYF- AP =0 4237 —X
EEEEERL —F TlE, A==2—BROZDIZ2 DO FENHESNLTOET,
B BE/ASAFL a2y —, F—FK—F, BLO<w x
B AlEASARNV A BBy TF AT Y= s [T 2 — R

1. mifE/ XL ® Touch Screen 7R # —

%TEF?‘:EKJ:D\ 5“/7“%7 Screen
Y AR DA b AT B 0 C:3<:>
xBENET

BoTF e AT V=2 %F 72T 5
I1Z1%. Touch Screen 7R % > 4 L
F9, 47 DIREET LED 25 54T
LiTo;@% ETH AT U—r
DA=a2—F~ T AEIETF—
Vo s

FE I TROWTNNICHEY T 25/, 2T « A7V = OFERNLETT,
B AR =T 4T AT L EHA AN VT D
B N—R T HART - RTATEZHWT D
B AT AT U= RELLRELRLS 2o Tz

Windows T A7 v P LD a—+ Iy M bZyF «c 27 V=2 T nld T LR EEL CGREY
FEITL TLEE N,
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T A—Z R £,

ARETDH LT, RIELANVLET Ty FREDBIENT A—=Z ZRET HLENH Y 7,
AT Y= ?4/%?( NOEDNRTA=BERET DI, 2y F3T2070 7L TEDON

WO T2 IEIRT D L. ZD/NT A—=2IT6t LCTIUH 7 REITR D £7,

AR VREAERT L EEE, WH 72 TEETN, UTICERRD FEICE->ThH
REXZEETH LN TEET,

1.

WL ONDRT A=K 21, HEIN
[ BORE U BNHESHTWET,
INHLDRZAFAE Y - RE
EHLMEENET, 7Yy s T 5L
WOHNREIZERETE ET,

BrotizBE¥ 51203, HnER
F— (14 ~—YZMH) ZfEHL
i‘é—o

W ONDINT A= TE, Ry
TT T e F—Ny R EIEF—
AR—FPRHEINTEY, HLwn
HaEANTEET,

F— Ny R (EFF—F—F)
TAar&27 )y 7458, F—
Ny R (EEF—A—F) B’%
RENET,

EE
B KT T YT R R EF— Sy RIE, ZRERY T R s F—R—RE YT b iy R

EESZENRDHY £,

Amplitude

Amplitude [z|

2 K2 K2 k3
D N e
B
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RunStatea >k O—J)LEHBADFY 147

EEREE R —Z CREERAEOHBBLMEL2a b —13 251203, UFDORT v 7 &2 ET
L%,

1. B/ S %LV RunAR ¥ 2 AL T
EERAEDRHBBE LS E 2 @4‘
Fre—L L FET,

BEEHRAEDT | A7 KL%

e [ Channel
Run State (Eh{EIREE) 22> b m— gméﬁm;mn
/l;;ktﬁia“o » (onrot) L”:E%%Eﬁé
155 M FE L TV A IRRET LED

AT —E PRI L ET, AT

2. Mhaxrs 206 iR ETE2H
F1+ B, miE SR AO All W
Outputs On/Off R % > F 7= 1%
Channel Output On 7R % > % #f
LT, EEHhadicd b

WY EY,
3. HDHWNEL, Settings 7V 4 RTUD Seftings
Chn (Channel) R—=UZfEHL T Ch2 | Timing | Run Mode | Trigger
{%%‘Hjj] ’i’ﬂ“/&lﬁhé Z k %_) VC% Output Waveform
£9, Settings 7 1 > F 72O 5]
< 0i\ 26 N— 5’7}3,‘3@ LT < 7LC Amplitude Offset Filter
3N
Waveform Rotation
[
Exk

B BF VO IIOF Y I AT he— L TExFT,
B BF xR0 TFu sl ~w— IR AT ENET,
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AR ITTI—RETART LA

ATV = e A BT 2= AR L THEGHEOT R TOMREICT 7 A TEET, 20— - A
VA7 2—A1X Windows XL —F 47 « VAT A ETHEEINTHET,

ARG —=2 A2B2T7x—R

18

U RY .
29 AAAN __Seque:ncg
VNV a4k
WaVefOrm LISt § gr;:;:[.:v CHZ:DZ1PHE: ‘ OFfs €2 Pos: ‘ O Ps
TA4vED Waveform
T4k
- oml
g Settings
LK R BRLLE | e 4R
Marker 2 High larker 2 Loy Marker 2 Delay Ml Direct Output
RE :
1 Digital Amplitude
JE—k - [ o0V
ATk - N— =

Aoa— /N — A a— N—NLHEBROTRTOBEICT 78X TExFET, A=a—IHHZ®
WITBHL, FndTdrarybo—n - Ry (FAT707 Ry 7 R) BRI, 20T
BN A=a—HENEEHICETENET,

ART—=BR IN— AT —H X « R—=TA=a— - R—=D FIIfMEL, BTV 7 - L—, B
EE—RIREE, HI AT —H A & OMEIGEmEFRRL £7,

Waveform List ™ 1 > K r2 . Waveform List (Z/Z 22— EFREIE L H LN LD ERSNI-KIED Y A
r23d 0D £,

Sequence VA K. ZDY 4R UL, EXV—F U AT IHERERRL T,

Waveform ™ 4 > K9 . Zd W ¢ > R 71Zi%, Waveform List 7213 Sequence 7 1 > K 7 TR &
N RFRRSNET,

Settings VA U F 0. 207 4V RDiE, RNIA—HBE~DI A7 - T7EALELTHESN
TWET,

DaAVRD B 2R )T Bl ET AT 4 RUDFETR ) ERTEDOELET,
JE—F - aATUF - N—  BUEOHEBECHE T2V E—F - avr RRERRINET,
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=N

BEERL —5 BEOERXTY T

AR DOBRBAEL, Aoa— - N—FFarbtae— -7 o RUEERL CTEEOER. WE
PITWET, Aca—BL0arhrag—NL - T 4 RTADT 7 ERAZONTIE, 20 X—J %5

LTLEEw, BREHIT5ICITROFIAEZFIATL £,

1. FHLWEEEERT 5121, Edit Edit View Settings Tools Syster

> Standard Waveform... % 333K L
Und Ctrl+Z
E9, ERL-HBIE. Wave- "I '
Redo Ctri+Y

Sequence Control Parameters...

form List 7 ¢ ' R 7 IZEREN I
9, @io Standard Waveform...

2. BEfFOR A AT 51X, File File Edit View Settings Tools
> Open File... TRET7 7 AV % n

R Waverorm Lt & 1 o 2 B Fﬂctnr]_r Default Setup  Ctrl+N

B Tl 2 A IR L & ()“—°W“”h ciro

¥ Save File Ctri+S

Save File As... F12

3. BifEE—F 2L £4, Set-
tings ¥ « > K 7 @ Run Mode '
N=UT, HESTLIEH;EE—F N N #diniaesd *
BIRSNTWD Z L 2L £
R

4, EFEREIEDITL, FIHEH/SF
IO RunRHF >, FHFAT—
HA « X—DO Run R H L #HL
7,

5, ROWTNNEFEHL T, Fro
FNVOH N EA L £, All Outputs ¢ irigy

L . @ BEORE EOANGING
® A/ %L Channel Output POREANG DT

On 78 % £ 721 All Outputs

On/Off 7R 4 > <

m Settings” 4 > F 7 Ch_X—T D

Output On &~ % w

ek

Timing | Run Mode | Trigger | Event | DC Output

Gated

B TEERFEERL—ZIZE, 4 208EE—RF2ZHESNTOETR, v —F R

Keex I — 2« £—F (Non-sequence mode) & IFESZ L3 W £97,
m =T R EFT=R T, FF v XAV T I OOH N EZBIRTE E7,
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Aoa—&UarvrkAO—JL D4R 9ADTIEX

KEAma—DavrFarybe—) U4 U RURTI7ERATHDIC, SESERFEIAR
ENTVET,

1.

20

A= a— « N—) D Settings & 7
Yy 27 LT, a~vrRE@RLLE
T

B L 7225 H 28 Settings 7 1 ' K
UCT T AT T,

REA=2—~D¥a—brTv b
L LT, Settings 7 1> R Z&{H
HATxEd,

Settings 7 4 > K 7 TCh 1<%
Timing DZ 7% 27 Vv 735 &,
ST H_R—UNERENET,
B2 DR E 2 18RS 2D DIl
ML ET,

BN, oY T
L—h, RIELL, A7 Y
bbb, BEOw— - L
NDEIRT A—FFHEIZTIERLL
T REATEET,
INLDORZLD 1 DET L
Settings ¥ o« ' K U Oxthsd %8
T A= PRI ET,

~UADEZ Y v 7 TEET S X
—a—HHBIICHBRICT 7 A TX
iﬁ—o

7= & 2 1%, Waveform List 7 ¢ >
Ko ETHIZU Y7925 L, BHHE
5 Edit Ao a—NEREINE
7,

,.Seﬂings Tools

System  Helg

Ch 1 Level
Ch 2 Level
Timing
Run Mode
Trigger
Event

DC Output

ol

Ch1gl Ch2 | Timing | Run Mode | Trigger | Event | DC Output
Olllpli\ Output Waveform

e |
Amplitude Offset Fitter

1.000 ¥pp 0.000 v,

Marker 1 High

[ o

Warker 2 High

g

Digital High

[ Y

Waveform Rotation

ing R
Sampling Rate SN

arm List
User Defined | Predefined

Waveform Name | Length | Date

Standard Wavetorm..

Delete

Delete All Wavetorms

Copy
. 3 Paste

Rename

Go To..

Wawveform Properties..

Marker 1 Low
000,

Marker 2 Low

[ oo

Digital Low
0.00 V]

Marker 1 Delay
0.00ns

Marker 2 Delay

[ 5o~

il Add Input

[ Direct Output
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aAvkA—IL g4 R DDORRUE

HFEHREERL —F DR U — 2%, T 74V T4o0aryro—L 7 400 RURKREIN

FV. VAR 27 EBALT, BV A R UOER /I FERRETIELUVEFEZDLZENT
EEN

1 . @]ﬂi‘:{— — F‘ 7j§ :‘/ — b‘ A 0) i}%é\ . File gunsam\j:R Eij::l::s/slnnls System _Help
T7HNETIE 40DT 4R
VI RTRETRINET,

Marker 1Delay
Add Input
Marker 2 Delay Direct Output
Digital Ampitude
7.0 VPR
e \d: AWGCRMOD SEQ T

2. Waveform List &% 7' /) v 7L = E‘"ﬁf“ M'"':;"" o
E

3. Waveform List 7 « > R U 8N FEF
RERD ET,

Output
on

Amplitude
2.000 VPp
W ) Digital Amplitude

G

mote Comman d: AWGC:RMOD SEQ
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ART—R R IN\—

AT —H A« RN—= L2 OOMREE L £, 7V - L—bh, Run 27—k, BiffE—R7
EOMIMOBAIED AT — X A% FRr L £9, S 51T, Force Trigger, Force Event, All Outputs

On/Off, BL T Run RZ U BEEBINTWET, TNLDORI 27y 7T 5HE ZRENDT
Jva rNFETINET,

22

BEORT—4RERRLET 7

Sampling Rate: 1.200 0000 GSis

Status: Running

5 Force Force
Run Mode: Sequence [Trigger I (St OO Run

® @

® ®e® © O

1. Sampling Rate P TV T L= N BEREINET,

2. Run Status R OEEIREE (Running %7213 Stopped) MBERINET,
3. Run Mode BEOEBEE—F Q9 X—U5M) BNERINET,

4. Force Trigger A & > A /X RV D Force Trigger 78 % > & [F] CHHECTT,

5. Force Event 7R & > A2 * /LD Force Event 78 % > L [6] UHSRE T,

6. All Outputs On/Off 78 % > il 23 /L@ All Outputs On/Off 7R & > & [A] CHRE T,

7. Run R ¥ AT/ X R /L D Run 78 & o L [A] CHERE T,
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Waveform List 9«4 > F ™

Waveform List 7 « > R 7 2i%, HEEROFEE (*.AWG) 7 7 A VITRIF SN TV DN Y Ak S
FT, ERFEHEIE L 2—PERKEO 25OV A FBHESNLTWET,

1. ERBEHWEERINT 51213,
Predefined # 7% 7 UV v 7 L %
ERS

2. TRBELWILOLBIOLEANITT
REY ARG P A (F) PO E
¥,

o EREAWIEE L. HIBR, 4

MEET L Z LT TE EHA,

3. —VWERKELRINT ST,
Waveform List T User Defined %
TEI7Vy 7 LET,

4. BIEOLTR, WEE., £ B M
JEICHEY A &Y —KTxF
7,

5. Waveform List 7 .1 & K 7 TlZ,
BRI HT I CRRINE
7,

6. EMERBEERLZMD 2V E ZiT,
WEZBINL THZ Y v 7 L,
Ry T T T« Ama—nb
Waveform Properties... 3% L C
RRINDXATAT « Ky 7R
THERTEET,

Ek

"

User Defined | F
Waveform Name | Length |Date

< i | =

Waveform Properties

Waveform Langth :

| L1024 Paints

[rata Ty
@ O Integer
L Ok J [ Cancel ] [ Help

B WaveformList V A RO TEZ Vv 7358, R T v« Aca—0NEKRENET, KE
DHIER, 2 B—R—A 2D A= a—RNFREINET,

n A—YPERBVEERT D & I,

ERFHWIE LR CARTEZ DT L2 LT TE LA, ERWKF

FWIE LT DAFTZ ST TS,

AWG5000 ) —X VA4 y Y « RA—k - 2—H - 3=a7)L

23



AVBRTI—RETAART LA

Sequence 1 VK ™

#{ET—F T Sequence NEESND E, ZDT 4 R UIIZY =7V AREDERNETRSNE
T BEE—RIZOWTIE, 29 2—TY%BHL TSN,

1. Sequence 7 « > K 7 DFRH|T EEFIETEE
'jﬂo %%7 T~ ]\ ﬂj“j‘.ﬁx* /l’ Total Time : 277 Current : 4 Running :
sV (Thumbnail) T3,

e
P EARANFRROLE, v T A% awd AW MAVVAANNNY

TIZEE->TW &, ZDELIZ . Samp|e4(QDDD Foints)
RRINTWDIIEOLTR & W : Empty
ERY— T v UhEWVWRy S 2.00 k Points
Tv7 U4 RY) TERRERN al >
£7
2. Table ZRDOH| T, Sequence
Total Time : 277 Current : 3 Running :
Ch 1 Waveform Ch 2 Waveform ait /4 L Event Jump To | Go To
AWG510B-1
AWGT10B
Empty 5
Empty 5
Empty
Empty 1
Empty 20
Empty e
ek

®m Sequence ¥V 4 ¥ R U TR I L7 IEA Waveform 7 ¢ > R VIZF RSN ET, BRIz BL
A R EAED ) £,

n BEFOWREEZ Y — 7 RHEHT 272012, ROFEPHESNTHET,
m Waveform List 7 « > K 7 D% Sequence 7 4 ' R U DENMIR Z v 7T 5

m Sequence V o R U TEAZFEL T 6, Edit A==2—00 Set Waveform... 7213 Insert
Waveform... 2~ > RN #9425

#{EE— R T, Continuous, Triggered, F7-1% Gated 23R Z415 &, Sequence 7 1 ' K 7 XA
7V —=rinbRENET,

Sequence V « ' R U Tld, FredT7 A arBMEH SN ET,

RET7AaY B
Wait Trigger

Repeat ( Z D] TlX Repeat count 73 26 IZF%E S AL TV ET )

Repeat (Infinite, ERIZHRD KL £97)

Event Jump ( Z DI TiX Jump ¥ —7 > SR A T v 7 A& 5 26 1C
HEINTNET)
GoTo( ZDEITILGoTo DF—%4w FH 26 ICFREIANLTVET)

HEBR™

24 AWG5000 > 1) —X 94wy + RA—bk - 2—H - 3=a7)L
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Waveform ™94 > K ™

Sequence 7 4 > K 7 CERE N7z A b F 7213 Settings U 4 R 7D Chn _X— Y TEINS
TR ZDOU 4 R UICFRRINET,

1. Z MU Graphic #7ROHITY,
Chl 2: Ch2 @7*137 . 5)\___& Ch 1:0.834 V Ch2:0.108V 7 p C1Pos: | Z00Pts c2Pos: | 400 Pis
L~w—T T ARERINT : ;
£

2, 2ODH—YVEHHL T, RWE
AR ECEET,

3. Table ZRDOBI T,

Ch 1:0.834V Ch2:0.108V A 2 C1Pos: | 33 Pts c2Pos: [ 39PIs =
,,,,,,, R WRE 1T S SR —

EVEk

m Sequence V > R & Waveform 7 4 R U DRRT +—~ > FlE, View A== — > Display
Properties ¥ A 7 02 « Ry J ZATERTEET, I, V4 FUYANTHEZY » 27 LTh
Display Properties % A 7 022 « Ry 7 RZT7 7 A TEET,

B TR T EDHR, v— T —EDH, EET I n T b~ — Ol EERIRL T
Waveform 7 (> R VIZRRTE ET,

m Waveform ¥ 4 U RUDWEET —% %227 V7 (FI#L) 3 5121%, Edit A ==— > Clear L
ES

m  TEEEL & ACE#E O BAL X, Display Properties % 1 7 27 - ARy 7 A& L TRO &1 0 3R

TEET,
m  TEE#H - Voltage 7213 Normalized Value

m  /K3HH — Points £ 7213 Time

AWG5000 ) —X A4y Y - RA—k - 2—H -3=aTFL 25
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Settings V1 Y F

Settings 7 4 > K 7 &M L T, Level (Ch1, Ch2, Ch3 3 X Ch4), Timing, Run Mode,
Trigger. Event, DC Output 72 & D/ T A= ZFT IR T 7 BATEET, RiE, A7y b,
=W eng/a— YTV T L= MR ERBIHEN SN NT A= ZITONTE, #iif AR
NDORZ PO RIRAEETT, A=a2—~DT7 7 EZAFECHONTIE, 20—V 2L TE
S,

Channel (Ch n) R—

1. Fxr 2O hEA Ny 51

6i\ Output On 7j< & Ve %—f 7 U > 7 o C ning | Run Mode | Trigger | Event | DC Outpu
L/ i ﬁ_o Ul ULEBUL Wervet ociT Marker 1 High Marker 1 Low Marker 1 Delay
B ; : d nrudmpm

2. IR, ATES b, T AV e |

‘?th 75? L—E < % i-a— Warve fosins Rulubive

o

3. KT v x0T Fua s s

HESEZMMTEET,
4. Direct Output®d 74> /4 7 Z 38R L

£7
5, V—F A E—KRPSHDLE 5

1%, Output Waveform 7 1 —/L' N Ch1 | Ch2 iTy In Mode | Trigger |

T, W2 @I Tx 4, Output utput Waveform

THANEOT AT EI Yy R =

% L. Waveform List # A 7 1 dmees Filter

U Ry s ARERSET. M

rm Rotation

6. >—H LA EFT—RUSNDE X,
7w 7 HI1E S OAAE (Phase)
F LB IE (Delay) # 3% ETE &

o

ek

B BT Y U REENENMSLL T OA LV | A7 2RETCEET . HLT ¥ VDM NRA
CRESND L, THurZMhe~s—AMOOW R4 12780 7,

m Direct Output 42T 5 &, 74N FEA 7y FORTITEDARY £, FHEREORE
HPHNEDY £7,

®  Add Input /&, Direct Output 234 7 @ & Z (L] T & £9, Direct Output 2N ER I TN D &,
Add Input IZHEZHIZ72 0 £,

m  Waveform Rotation |22\ TlE, 62 X—Y 2SR T E &,

26 AWG5000 >y —X A4y« RBA—F +2A—H - 3T=a7I
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TR I Tk

1. AWG5002/AWG5012 47> =3 v
03WClL, TUHINL - FT—HH
FIDMEHATREIC 2 0 £,
#%ESZ AT Chl . Ch2 HIZ
FNEN1AE Y DT X)L -
F—Z D SMB =2 %7 Z )N
HEISNTVET,

2. Settings A ==2—T, L~
e NG A=Z L L TROWTR
NEfEEL £,

m Digital Amplitude/Offset
m Digital High/Low

FTUHXNVHIOL VIR LB
nTT,

B —1.0V~+2.7V, 50 Q K&

m fiFRE 0.01 V

3. Digital High/Low % f&7& L 72354
@ Settings 7 A K7 Ch 1 ~*—

:‘/“VC\‘—?—O

4. Output On TEZDOH &R L
ij‘o

)

el
o

o

11

® >
OECEOEOCOEHE QEODODOD @
Q.0 &

Settings

Tools Systemn Help

Ch1

Amplitude

T.000 ¥pp

Waveform Rotation

Ch 1 Level
Ch 2 Level
Timing
Run Mode
Trigger
Ewvent

DC Output

Analog Amplitude/Offset
Analog High/Low

Waveform Rotation 4

Marker Amplitude/Offset
Marker High/Low

Digital Amplitude/Offset
Digital High/Low

Output
o o4 =

Coupling...

iming | Run Mode | Trigger | Event | DC Output

Output Waveform

Marker 1 Hip Marker 1 Low

Marker 2 Hi \ Marker 2 Low

Digital High Digital Low

Marker 1 Delay

Offset Filter

Marker 2 Delay

[ oton

m Chl & Ch2 ol WHEMIay he—ATEETR, THas/HhET Y2 VH L, FRHCA

VIFTENET,

AWG5000 ) —X A4y Y - RA—k - 2—H -3=aTFL 27
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28

Timing R—

1.
2,

Sampling Rate Z 5% /&L £, o 0 0

:‘/_ b‘ V X * ‘:E _ F‘ D\%O) & % | Lh2 | Timing | Run Mnd Trigger | Event | DC Out
Repetition Rate % gﬁ ﬁi_‘ ’(w‘ % i \j—o @ sampling Rate Clock Source External Reference Type

© Internal @ Internal © Variable Multiplier Rate
vy 7+ —X (Internal 7213

External) %@*R L/ ij_o w ® External Divider Rate © External ® Fixed
m External ® & (%, SMHA T

(2)

L—Znb0ray JEEN C’
fER SN ET,

m Internal ® & XX, 7mavU{E
FIINECEREINET,

7y 7« — A7) External O &
% . Divider Rate 2 ETCX F
9,

Y7 7L A+ —Z (Internal £
721% External) Z &R L £7°,

V77V A Y —RFrmay
7« Y — AN Internal D & <D
HEHTT,

Y 77 R B AT
(Variable ¥ 72/ Fixed) % &R L
~i‘a—‘o

TDINTA—=HI, Iy 7
Y — AN Internal TV 7 7L
A« ) — A7 External ® & =D
HENTT,

ek

Yo7V T L—RiE, Zav s o V—Z23 Internal T, M ORDWNT DO FAEZ - &
XIRETEET,

m V771« Y—2Z7 Internal ® & =
B U7 7L 2R =X External T, M5V 7 7L A - Z A7) Fixed O & %

TE®REE R —&IZ, Fixed /) 77L& « V—Z L LT, 10 MHz, 20 MHz, F7-1%
100 MHz DfE 5 &= T AILE T,

a7« —ZN Internal, V7 7L A&« Y —ZMN External, MY 7 7L R« X ATN
Variable ® & & Multiplier Rate Z 5%/ E CX £9,

Timing ~X— DTG A—ZDREL L PIZONTIE, AT A2« ~ATEBRLTLES
AN

AWG5000 > 1) —X 94wy + RA—bk - 2—H - 3=a7)L
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Run Mode R—

1. BEE—FR 28I L £,

2, ]\ U jJ « F— R k /7 ]\ T— ]\ : Ch2 | Timing | RupMoae | Trigger | Event | DC Output
TliZ. PUHFLOIRETOHA ® Continuous O i ® Gated
EZEIRNTE £ Output value for waiting state
= First— 771 ~L & L THETE Iyl =

DR OMEZFHEL £

m Last— 7L ~L & L CHB
DEHOEERREL £,

Exb
n EEEEERL —ZIZUTOEEE—F 2R —FL 3,

= #f5¢E (Continuous)

L A S vk,
m [ U (Triggered)

® Sequence

AN D VT EFEZE L L ZIT 1 SOEBE AL £3, L2 DL 72&IE, kO

N U IME S OIREIZ/R D £7,
® 7 — I (Gated)

T METBAENIRIRED L 20BN/ S ET, F— MESHAMZRMITER L 72

BN S ET,

m ¥ —/ 2 X (Sequence)
= ATRERINTNEFICHE > THEBEOEESH TS ET,

AWG5000 ) —X VA4 y Y « RA—k - 2—H - 3=a7)L
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30

Trigger R—

1.

3.

N YU #H « Y —A (Internal £721%
External) # @R T £4, 7
7 #/V ;X External T,

External Zi&R425 &, FNUF -
Ly, MUK e 2= MY
He AV E—F L AERETEE
7,

m Level - ITDONI A -
LAV EREL £,

m Slope—MHB Y TE2EHT 2
L&, Y. kD (Positive), . [
D (Negative) DEH LD T
CThUBENTDNESRE
LET,

» Impedance — M~ U T DA
V—H AR RELET
(1kQ 721X 50 Q).

Internal %%+ 2 &, HNEIHN Y
HORMY TEBREFRETE E7,

ek

NUBONRT A=H0, G5 hEEE2ar bo—1 L Ed, P TONRT A—=HF, @fEE—
K 7% Continuous ® & IR TETE FHA,

Ch1 | Ch2 | Timing | Run Nk Trigger | Event | DC Output

Source
® Internal O External

L Intenvall Level Slope Impedance
H

FUAT -V —=ATERLIAZFHOIENIC, R/ SRV Force Trigger A ¥ &L TH MU T %

RETDHIENTEET,

AWG5000 > 1) —X 94wy + RA—bk - 2—H - 3=a7)L
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Event R—
{ET— A Sequence D & XM TE ET,
1. SN A N R ANDOL TVVEAF  [EEE
'J/:E[/ i“g"‘o Ch2 | Timing | Run Mode | Trigger | Event | DC Output

2. SN A~ b AT OREE (Positive o - o
F 7213 Negative) 2R L 77, [0 14V olar ump Timing

m Positive ZHEIRT 5 &, /LR
DN ERY Ty T LET,

m Negative ZEIR$ 5 &, /L
ADNFY TV T LET,

. Uy H AT (Asyne -

I% Sync) Z IR L £9,

B Async ZEIRTH &, Uy
TR LICFEITENET,

m Sync ZERTLHEL, Py
IFBRIEDWRFEEZH I LTcd &
TIITSNET,

4. AV RNADNAVE—F 2 A(1kQ
FZIL500Q) ZREL E7,

EVE
B AUk s Uy (BventJump) ElE, V=T U RAEANRY MESTHID X HHERETT,

m V¥ XA 71%, Event Jump & Force Jump O G ICHEA SN ET, v — 7 AICBIT D
VT ONTIER, 67T X—=VESHL T &,

m B/ SRV D Force Event R % > & #3 L NEA XV M B2 RAETEET,

DC Output R—

1. {EEEFE XL — 4134 5DDCH s :
jj %ﬁ% \gz_a_o Ch1 Ch2 Timing | Run Mode T::u{ger Event DC Ofn:m

DC A D L~ ERNC R E T / L
X F9,

2. HAREE (v /A7) oy
2L T _TDH DC HAIF v o %L
(23T,

AWG5000 ) —X A4y Y - RA—k - 2—H -3=aTFL 31
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T4 ILE

RE

Al 2% /L @D Factory Default 78 % o 2 #i3 & TH ARG E X MO T Z &N TEET,

1.

FERR ORBUE 2 L5 HATRpR B L2 R

FIZIE. Al SR/ D Factory
Default /R % > &L £,

RENEHESI LTV D56, BUE
DEREZRFET HMNE D AR

THXAT T Ry I ANER
ShET,

File X == —25 % L HHTERGR
EZMNOHTZ ENTEET,

INTD —- U BRO#MRERTE

BIRBRARFCIFOH S o E 2 BIRTE £,

System > Preferences... =% L T,
Preferences ¥ 1 7 07 « iRy 7 A%
KRLET, LTFOHFNLERKEA

RF DR EZIEINTE £,
1. Factory Default — B ARFIZ,

32

THHMRRENFFOH S E
ﬁ—o

Last Used File — IR #& AR IZ, &%
BAIREFZTLIIMEOH SN =R E
BIFEORH E N ET,

User Default File — EEJR#& ARRIC,
= PRIRELTZRIET 7 A /LR
WIS ET,

TFANE T Aarwz )y 79
DERET T ANERET DD
DHEAT AT « Ry 7 ARFIRE
hi‘?‘o

Z DT A =2, User Default
File BRI N2 & 2GR
Di\j—O

Open Save

p - <
| P W—
Facto[ ﬂefaul i

—

AWG5014

| Wes | l 8] l l Cancel l
File Edit View Settings Tools
Factory Default Setup Ctri+N
@ Open File... Ctri+0
Sawe File Ctrl+S
Sawve File As... F12

Preferences

Startup

() Last Uzed File

e () User Default File @
il

AWG5000 > 1) —X 94wy + RA—bk - 2—H - 3=a7)L



File AZ21—%&EHAT S

File A=—a—%{EHT 3

R TE DRI L, T — 2 DAV R—, =7 AR— K ORAKI R 7 7 A VHEE
X File A==—%FHAL £+, £/, HEFEALZRTEOFEOH L 22 E O Windows OFEAER) 7 1
fE% File A = =2 — T\ FE 7,

TiDA=a— -+ a<w KA File Aza—|IHEINTWET, HA=a— - a<2 KNOFEMIZD
WTCiE, AT Ay « ~NTEBBL TLIEEN,

1. TGMATREER ELZFFON L £97, ile Edit View Settings Tools S
32 <V B @
e Factory Default Setup
2.%%§E%m—Fﬁé§w@ﬁ4 Open File... Ctri+0
Tary Ry I AEFRRLET, oy s
3. Mo EEMRST (LEX) LE Save File As... F12
EE i ) Import from File...
4. BEROBIEICANE DT TRIFL Export Waveform to File
by -

1 CLAWG 'Sequence-4.awg

2 CLAWG\Sequence-1.awg

3 C:L\AWG'2CH100SEQ.awyg

4 C:LOAWGVer2'SetupdCH.awg
Exit

5. Wik —#% A A" —FLET,

6. KT —Z&MoT 7Y r—3 3
CERAT A DI 7 AR —
TxE7,

7. W7 7B ALTERET 7 AL
ZZIERENET,

8. 77U Fr—TarE R TLET,

9. 7Y —a KT L., e
vy hE U LET,

Shutdown

(@) (=) @@@@@

ek

B T U=y a s wRELREET, BRI/ SFAL DT — « R X (On/Standby A A > F) &
FTZEICED, ERET Yy N YT HI R TEET, NY— - REUET L BIEDRK
EERIFTDNE IMEHRTIHZAT T « Ry 7 ANFREN, ROy hF T -7
2EABRBINLET,

AWG5000 > 1) =X 94wy + RE—bk - 2—H - 7=aT7)L 33



File * =1 —%#HAY 5%

BBEREERETDS

BEOREZRAFT 2121E, FTROFIHEZFEITL £,

1. ??}:}dﬁ Save Fi:; E‘:@iﬁ}%?;; fi’)f‘: . BE File Edit View Seftings Tools
FOREARR E # CEXE
Factory Default Setup Ctrl+N
= L C E#E R
7AVTERSLET @ Open File... Ctrl+0
2. BUEDORTEEMLVEEY 7 AV - L
LU TERIFET 5121, File > )
Save File As... Z1#HJ 57>, % @ S Fig
721X R X%V @ File — Save R
2o EMLET,
3. FRINBEATOT Ry 7 A . B
T, REERAET B BT & R L e
ij_o Save in |_} AW _Files_Mew v| Q ? = =
4 T ANEGENNT DD, FT 4 (}3
VN OA4RTEEAL £7, Dociﬁ':?::i
5, Save # 7 U v 7 LET, (F
Desktop
Y/

@ ®

| 1
File name: d Setupl.awg |l | Save ]

My Metwork | Save as type: | awg [*.awg) v [ Cancel ]

Ek

B REERGET DL L X, WETZ +—~ v b2 Integer DAL, BRET 7 ANVDOH A XIS L 72
DES, WEOT—4F - 74—~ b (Real £721% Integer) IZDOWTOFEMIT, AT A2« ~
NT BTSN,

®m Waveform, Waveform List, Settings D& 7 4> K7 T, WEDO T +—~ v b 2E#HTH L 1L,
Waveform Properties % A4 7 22 « Ry 7 ZA&EHL £7, 56 X—VZZML TS0,

34 AWG5000 > 1) —X 94wy + RA—bk - 2—H - 3=a7)L



File AZ21—%&EHAT S

WBREE U

File A== —%721% Windows Explorer 7> b B#Rak E 4 MO Z LN TE E7,

1. File > Open File... Z 3§25 & | File Edit View Settings Tools
OpenFile ¥ A7 07 « Ry 7 A
o e — Factory Default Setup Ctri+N
MFERINET,
& 7 @ Open File... Ctri+0
Al 2%V D File — Open 7~ % - "
Z 1L T% Open File ¥ A 7 1 - s
7Ry 7175;@;@‘&32%&@—0 Save File As... F12
2. RIET 7 ANVEZERL £,
3. Openz7 1V v 7 L%ET, Look in: | £3 &wG Y od @
Y [y amic_Fies
bﬁ @Sequence-l amg
My Recent
Documents ;
— [ Setuipatit, 2w
[ @Setup_File.awg @
Desktop
a7
My Documents
w9
tdy Computer @
h__- File name: _Setup1.awg _V. Open
by Né‘f;vJD[k Files of type: awg ["awg] v|

ek

B EEEEERL—ZTE, IEFS AWG DT 7 ANVERET 7 A/ E L THEHL £7, Open
File 47 w7 + Ry AT, 774NV ET.ANWG DT 7 A VDOHEBPRRINET,

B WVWoZAREZFFOHT & HFOH I N7Z5REL Save File F721% Save File As... E{T3N5 F
TSN E T, BT A—2 %27 H %, Save File &R+ 25 L, RET 7 A /MWL D
W hEEXINET,

B HET FANDBIFOHENS L, DCOutput ZE Lt AT — & 234712780 £7,

E AWG5000 & U — X8 LR AWGT000 > U — X THERR L7238 € 7 7 A VITIF ABERH 0V 5
B, BRETZ 7 ANVT OB AT A—=ZPUERROY R — FEHZ B TOL5HITEE Ay &—
UNRERINET, ZOHE, @WHNADONT A= FT 7NV MELRY T,

AWG5000 > 1) =X 94wy + RE—bk - 2—H - 7=aT7)L 35
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BsT—32 DA 2 R—F

T4 e A= MEREIC L > TABG LIS TR SN CIE T — 2 232 Z & TE £7,
T8 AR = L THLWERZER LY BFORET —F 2 BEHADL LN TEET,

EEEEERL =213, ROT7 7 ANV R —F L ET,

36

AWG5000 > U — B L AWGT7000 >~ U — X TIER L 72 *. AWG 7 7 AV

Tektronix AWG400, AWG500, AWG600, AWG700 > U — X TIERK L 72D 7 7 A VI

= *PAT
= *SEQ

= *WFM

Tektronix AFG3000 3V — X CIERE L 7= * TFW 7 7 A /L

Tektronix DTG5000 ¥ UV — X CTERK L 7= * DTG 7 7 A /v

Tektronix TDS/DPO 3 U — X F 3 1 2a—7F TIER L 7267 7 A /L (*.WFM., *.ISF)

TFAD - T 7 AL (*ixt)

T AN AR—=FNOFEMIT, AT Ay - ~NATEBRLTLIIEE N,

1.

File > Import from File... % 5241 9

% & Import from File # 4 7 &
TRy I ANRFRINET,

AVR—= T DHEET—ZD
T —<v b EBRIRL £,

OK%7 Vw7 LET,

AT w7 4R T XD 7, File
Import ¥ A 707 « FR v 7 AN
FREINFET,

File Edit View Settings Tools

Factory Default Setup Ctri+N
Open File... Ctrl+0

Save File Ctri+S
Sawve File As... @ F12

Import from File...

Import from File

) SWGEE000/7000 [ AWE)

() AwWGEA00/500/600/700 [ PAT)

(O #wWGA00/500/600/700 [~.5EQ)

() AWGA00/500/600/700 % wFM)

() AFG3000 [*. TFw)

@ () DTGEE000 (DTG

() TDS3000, DRO4000 % 15F)

TDSA000. TDSE000,
() TDS/CSATON0, TDS/CSASM., DSAS200,
DPOYO00. DPO/DSATO000 [ W F)

() Test [ TXT] @

(%)

I ok | ’ LCancel ] ’ Help

AWG5000 1) —X A4y Y - RA—F

caA—H-2z=aTFI



File *=Z1—%FEHAY 5

4 A VR—=FTD57 7 A/VEFIRL

iﬁ—o

5. Operation T >R — b EifEaf5
E]\/ iﬁ—o
m Set to

Frrpe AT v 7 AFK
FERELET, fRELA
BIZA R — T B E
DY THENET,

= Insert before
AR =T HWEENTEEL
7BV ORNCFHEA S ILET,
BiEE—F 0y —r o AL
DFE., TDORT A—H T
72 ET9,

m  Create only
A R — KT B Wave-
form List 7 (> K 7 IZFE R E
ET,

m Overwrite
BEFORET — 4N EEX X
nEJ,

6. Change H/W Setup ZfH L T, A
YRR T 2T
Uo7 - L— b ROIRIE, A7y
N DOERNBE ENDGE, ZORE
PHEEEETEET,

7o & 21X, Sampling Rate %
Fxvr9HL AF=bT5
T2 LRECEEAFEEND X
T, BTV - L— bW
UNIRESNET,

7. Open 27 U v 7 L £7,

AVR= T IEROT —~
k23, * AWG, * DTG, *TXT
OEGAEE, ENENICKHET D4
AT Ry JANRRINE
7
AR T OWRDOT =~
k23, * AWG, * DTG, *TXT
DSAOEGAEIEL, BIRLTZT7 7 AV
DA AR — S, ERAD
Waveform List 7 4 > K 712U &
hEnET,

File Import
Lok in: | £ Awe v © 2 o
iy (L5 AwiG_Files
L\,,ﬁ C)ver?
My Recent ) aveforms
Documents || ] 2CH100SEC, awg
= Sequence-1.awg
@ ﬂ Sequence-Z,awg
Desktop ﬂ Sequence-3,awg @
ﬂ Sequence-4.awg

ﬂ Setup3.awg
ﬂ SetupS.awg

My Documents

by Computer @

@Q Filenarme: Sequence-1.awg ( 6 \ v | | Open ]
. : \ / =
Ay Metwark.  Files of tupe: | &4/ [7.awg] v| [ Cancel ]
Operation Change H A Setup
() Setto Indes Mo |1 ; atCh i1_; [[] 5ampling Frate .
) Insert before [ &smplitude/Dffset
() Create anly
() Overwrite

AWG5000 > 1) =X 94wy + RE—bk - 2—H - 7=aT7)L
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Fle AZ21—%ERAJT D

8. fVAR—FTDHT77A/LN AWG File Import
Tektronix AWGS5000 > U — R &%
7213 AWGT7000 > U — X D4,
FEOLH>RZATaT « Ry A

Waveform Name Length Date

NFRRINET, "
A A= THEEE RN E
TO

9. OK%# 27 Vv o7 35L, WET—
EWRAR—FEINET,
— BB O T — 2 A
A—hTDZEnTXET,

10. F o AR—FFT257 7 AN
Tektronix DTG5000 >V — X D5
G, Aok osd AT s - KRy AWG bits
T ANKRRENET,

1. £ > A — k732 DTG5000 > U —
RXTay s« T—=HDKE v b
(DTG bits) Z# ABEIHOE > b
(AWG bits) 12#10 4 CTE9,

38 AWG5000 >y —X A4y« RBA—F +2A—H - 3T=a7I



File AZ21—%&EHAT S

12 A KR—=FFTBT7 7 ANBTFA
ke 77 ANDEE. HEDXH7
HATaT « Ry 7 ANRERSI
7,

Format T, 7 7 A VB EHRE
L iﬁ—‘o

13. Normalize T, /—~J7 A ADF
EERINL £,

= None
)=~ T AREITVERE A,

m Fit to DAC Range, Preserve
Offset
0% AL L CAFr—) 7
SNET,

m Fit to Full DAC Range
TTDT —H DE/IMED —1.0.
BRMES +1.01225 K91
F=U 7 InET,

14, A R — N FEITHRRZ, R AFRD
BN TITHFEL T DHEE.
FOXHI A ATas « Ry 7 A
DERRINET, WEEESHZ
A5A1%. Yes £7-1% Yes to All
RN L F9,

ek

Text File Import

@ Formnat

(%) Analog

{7 Drigital 14 bits
@ Mormalize

{(#) Nane

{3 Fit to DAL range. preserve offset
{3 Fit to full DAC range

Lo J|

Cancel l [ Help

Co&

Confirm Waveform Replace

Current Setup already containg a 'wawveform named 'S ample-1°.

Wiould you like ta replace the esisting wavefarm

YWaveform Length 960 Points
modified:  Saturday, Jun 24, 2006, 4:25:44 Pk

with this ate 7

W aveform Length 960 Points
modified:  Saturday, Jun 24, 2006, 4:25:45 Pk

@ —= 1 « J[ =

BT LWERIEZERT DL XL, AVR—F L7 7 ANVDOATIDFBIMER OB B4R E 720 £

B

B 77 A AR — R
CIRERICEEINET,

SATTB &, BEEOWH DY A KA VK — b SRI=T 7 A 4 L

AWG5000 > 1) =X 94wy + RE—bk - 2—H - 7=aT7)L

39



Fle AZ21—%ERAJT D

BT

— 2 DITYHY AR—Fk

FEEREERL =i, —0DOEET — 4% xtEXDOT7 7 A VICEBRL T2/ AR—FTEET,

1.

T AR—FTOHREEEREL £
4, Waveform List 7 4 > K 7 |
TEEEZZINL £7,

File > Export Waveform to File...
EENTDE, ¥ AT T KRy
JANFRSNET,

WET—4% « 77 ANVERGFETD
BT IR L £,

Waveform List V7 ¢ > K v T
RUTZWEOARINERIILE

T

Save 7 Vw735 L, fBEL
BT — 4% txt BT 7 A
NLEL T AR—F TE LT,

ER
T AR—=FTDBWET—FD7 7 ANEXE LT, KOFNLLIBEL £,

40

m Text (*.txt)

m Text — Digital 14 bits (*.txt)

Wit aweform Lisk

@

Export

=
I
o
]
]
=2

Documents

My Documents

Wy Metwark,

User Defined

Predefined

Waveform Name | Length | Date

Save jn | ) AwWG
]

3 02 @Er

) AMG_Files

[Z] Ramp1024.bxt
[Z] Sine1024.kxt
2] ToS.txt

©

@

File name:

Save az lupe:

.| sihe 32tk

]

L_sae |

| Test [*hat] v |

[ Cancel ]

Y=y A= RNTE, EEORLVERIRG, A7) v 7V TRRENLIR T T o7 A
Sa=hbX AT RS Ry J AERRTEET,

AWG5000 > 1) —X 94wy + RA—bk - 2—H - 3=a7)L



Edit A= 2 —%ERAJ D

Edit A=21—%2EHTS

Edit A == —Z#HL T, HrLWBEIRZIERLZY . BIFORFE2RETE £7,

1. Undo %, REOT mEAZIY @
HLET, dit View Settings Tools System Help

Undo 1%, I— Y&, X —2A4, @ Undo Ctrl+Z "
BXOx 7 o— W fSECITmMH & Redo Ctrl+Y
nECA, Q= -
2. Bedo E KEBEOT e RAZ#EY Sequence Control Parameters...
BLET, @ Cut... Ctri+X
3. Standard Waveform % A4 7 1/ - Delete... Del
By 7 AERE ET @ Delete All Waveforms
4. Sequence Control Parameters % @ Clear
7137 * ﬁ??nggﬂ%iﬁ—o CUPF... Ctrl+C
5. Cut £7-1X Delete ¥ 1 727 - Paste Ctri+V
Ny 7 2A%HEET, Insert Waveform...
VU ATRET Vv ay s RA @ Set Waveform...
e ET, Paste-Insert
6. Delete All Waveforms |3, i il Ll
T ANNDTRTORET — F Rename... @
ZHIBRL £, Scale...
7. Clear I3, ®IRLZv—F 2 & - Offset...
TV AVNOT—X%E 7 VT (H] Invert...
Hib) LET, =7 2050 -
DF =KL T N LEEA, @ e
§ . Marker/Digital Set High/Low...
Waveform 7 ¢ > K 7 G, &ER
LT vy R OWTET— 4 % 7 Waveform Properties... PRBES...
V7L ET, Set Pattern...
8. Copy P Ty C!uck Pattern...
x ¥4, Binary Counter...
VT VATIET 7 ay s KK
e ET,
9. PastelZ, 7 VU v 7 R—FoHg
% :[ to — I/ i ‘a‘o
10. fREBEOK O (T a s -
Ry 7 2&f&EEd,
N~ —IREDY T A= — % &
7
12. Waveform Properties % 4 7 127" -
RNy 7 A%REET,

AWG5000 ) —X A4y Y - RA—k - 2—H -3=aTF)L M



Edit * =2 —%ERAT 5

RAER T D ERL

Standard Waveform # A 71 « Ry 7 AZEHAL THLWEEEZIER TE £,

42

1.

Edit > Standard Waveform... % %
4% & . Standard Waveform %

ATaT « Ry 7 ANRERINE
7,

Function T D ¥ A 7" %8R L
9, AU, AN HE
., 07, Aoy xy - A
R F721EDC S EEINT
xFET,

Timing Ti&, B, HEE. B
TV AT NVDENRT A—H mik
ETEFET,

Sampling Rate T Auto, No

Change O\ N2 HEL %

R

= Auto
15 75 AR RS U Tl B 70
BREYCTI T - L—h
DHERICREINET,

= No Change
YTV s L— MIZE(L
LE¥A, FEE Bk,
FAINLDIHD2 DD
A=RERETDH L, EOVD
1 DIFEBMICHRE S ET,

Preview |2 N E RS NVET,

® e ee 6

AWG5000 > 1) —X 94wy + RA—bk - 2—H - 3=a7)L

Edit View Settings Tools Systen
Undo Ctri+Z
Standard Waveform...

Sequence Control Parameters...

Function

Tirnirg

Frequency “ |

120.000 00 MHZ

Cycles A |
W aveform Length 100 Paints
Sampling R ate

) At
Mew Sampling Rate - 1.200 000 0 G5/

(%) Mo Change
Cumrent Sampling Rate : 1.2000000 G5/

Freview
n.snou_IIIIIIIIII
l]-mmu_IIIIIIIIII
-0.500 V -

Points 0 50 100

10



Edt *=a2—%FERT 5

6. Level C.IRIE/ A7y b E721X Level
NA LB DRT A= S ERBGET @ Amplitude / Dffset
SET (6)
_ . ) High /L
7. Option T, #Eif /47ty h D O High / Low
TEN LA #RIL £9°, Option 7 Ampitudz - | 7.000 000 vpp
L —Ad, HEEHH O BAZIZ Volt-
age BN L 12 L EOHRRREN Rt | 0.000 000V

EXE @ [ pticn

e[ i O BT (Z Normalized Value
PN A L Option 7 L — A% (¥) Use specified amplitude and offset to calculate data.
I F3, TREEIO B

= : \ o33 i% HE
ENZDWTHL, 59 = 2 2R ~ Create data with DAC full soale valus. Specified

L TL7E&E A " amplitude and offzet are directly applied to HA setup.
8. Operation T, WEDOIERRFTIESR
LB EZITVET, :
Operation
m Set to
Fx L RN ATy T AE (%) Setto Index Mo |2 vl atCh|1 |w
%%}??‘ET‘ELT\ HBICIE T & () Inzert before 1 el
N ) g ~ = arget W aveform Hame
ﬁfﬁ L i‘a—o /:FEj EL 77:—{&% = () Create anly
YERC U 72 T A v S
*7, () Oevenrite
= Insert before ' avefom M ame:
YER T 53 A Sequence 7 Untitled20

YR UOFREL RO
fASINET, BfFE—FN0
y—b‘yxﬁ%@%é\\ ) [ Execute ] [ LCloze l [ Help
T A= H I T, C)
m Create only
BB 2 ERR L 9725,
EREIre—RKEhERA,
Waveform Name (2K D4
ME AL ET, fElshb
1% Waveform List ™7 ¢ &
Ry Oa—FERERY A b
WZERSNET,
= Overwrite
BEFOWRET — 4N EEX X
NET, Zoa<r R a2ER
5L, BlifEr—R 3T
% T )N Target Waveform
Name R v 7 ZIZE RSN E
T, WARE AT T DR Y
27 A (Waveform Name) | #E%)

W20 £,
9. Execute # 7V v 735 L, FKE
PER SN ET,

AWG5000 > 1) =X 94w - RE—bk - 2—H - 7=aT7)L 43



Edit * =2 —%ERAT 5

Cut/Copy/Paste/Delete % fEFi 9 % (Waveform V1 >k 77 )
FBE L 82 A e O 7 ) v 7R —RNIZhy hERidae—C&Ed, Iy hERidar—
LT —XI%, VI 7FRR, T—ITARROELLDOE—RTH, HELAEICR—ATEF
T TNODOEMELETTLLEE, BET AT LV VEREEELET,
B By NERIEIE =TT AT I T LB T X F9,
B All-TXTOT AT LR%5
= Chn Analog data
= Chn Marker 1/Marker 2 data
B By RERIEOE =T AL VI T LRIRTE £,
B All-FTRTOT—Z% Ty hFELiFar—
®m Between Cursors —2 DD — Y )V OEK A B~ b £ —

m Selected (F—7NVRKRDHR) — vV RAERN Ty 7L Thy EIZaE—F HHEBZERL
F9, Cut ¥ A7 as - Ry 7 A0 Range 7 4 —/L R Tl Selected 3 F = v 7 S ET,

T N7V 7PR—RiL, AR T 7 r— 3 HNIZH Y, Windows D7 U v 7R —F &%
BIDE DT, Microsoft Excel b ARMEZRD 7 ) v TR =R T — X ik +hZ L3 Tt
o MOT TV r—2arnbDT —FEETIE, AR —b /27 AR—MEEEZHHL £7,

Cut £4EH1

Waveform 7V 4 > RO DT 7RI THT—TNVERTHL Iy FEBIEEZEITTCEET, TN T 7
TRIRDOEEZDH v M EEGIZ R L £,

1. Waveform 7 1+ > R CTh v b7 Waveform
5745“5%‘?57331_/&#0 : 8 : 0Fts c2Ppos:

44 AWG5000 > 1) —X 94wy + RA—bk - 2—H - 3=a7)L



Edt *=a2—%FERT 5

2. =Y NEoTL U VERIEEL
i ﬁ—-o Waveform

C1Pos: 49 Pis €2 Pos:

3. Edit>Cut.. Z#RL T¥ A7 1

TRy I AFTRLET,
Waveform 7 4 > Ko L CTHZ e
Uy 7 LTEREINDIR YT T v Oal
7 A= a—n b Cut ZEIRT D
- g: %) T% 35—’9’1) (+) Selected
VUV OREEER LN E X Riange
E. ZoX¥ATRT - Ry JAT O Al @
ERCTEET,
{+) Between Cursors
4. OK%7 U7 LZET,
I (]9 J [ LCancel ] ’ Help

5. Iy bNFETENET, WISV
ZhL., BADEDIET 7 AV B
ETHD HLET,

. —HOT AT LDBHy b EE

HIFRES N THEERITELS 2D £4

o T—HIZTTZ7RNLET, 7k

L=k D% O 3IE, 77 40 b

EAAND 9,

I6: 404 Pts C1Pos: 43 Pts c2Pos:
[z

EVR
m Delete (HIFR) 1INE 7Y v PR—FOREBEREDLLRNWE W) SERS ED Yy M ERILTTT,
B T RNTCOTAT LNy bFELIFHIBREIND &, BEEZZOZEL D 7,

AWG5000 > 1) =X 94w - RE—bk - 2—H - 7=aT7)L 45



Edit * =2 —%ERAT 5

O—HUADESE
DUT DR EET A 2475 121F, LIELIZEWEIE Y 7 AV E2ERT2XLERH Y £, E
DD IRENDGEE, WEY —7 v ZAEEICL > T, REDOAEY) 2EET L0 s T3
THVEE A KBS+ 2 ENnTEET,
= AL ERTHROHBTHERAISNET,
B R 2TOEREATI) LDLEWVWKEAZHILIZWnWE X

B HOEEEPEETCHVEZ-WWEXx (ATET U A— a3y d)

1. V= RAEEFRT DL, Edit Edit \iew Settings Tools Syster
> Sequence Control Parameters... T —
BBIRLTHE AT Y « Ry 7 A
rRALET,

Standard Waveform...
@ Sequence Control Parameters...

2. Y?it;zg/gggjg;gi E j;“é k @ Sequence Gontrol Parameters g|
DWTEZE I3 DN N U T & 1ff e
HET, ] W/ ait Trigger

3. VLU ADEKZE L AT @ [v] Repeat
Repeat 7 7 F NMfEESND &

WIENFEE SN REE D RS () Infinite () Court : 1

i'@’ﬂo

4. Event Jump To (X, #MiA <2 |k
K-> TEBOHNIEFZ 2 H L

F9 (%) Mext () Index Ma : Ii‘]

[w] Event Jump Ta

@

PH—k ENDH ARy MMEEICO @ ¥lGaTo
Wik, Fitober M &R,
5. v —/4y A+l AL hZ Go To index o i
=2y NERETDHE, BES
ﬂf:&%@ﬂjﬁbﬁf@b@&%\ OE. ] [ Cancel ] [ Help l

—4 o HiE Go To THES N
Jmob A b ~HlflEZRL 7,
Go To MEE SN TW R WEAI
RO A RS
1TL £9,

ek

m B{FEE— K T Sequence BMEESND &, v —F L AERICH S THIFOH AN ThILET, v —
TUARRITER T DY =T A s TV AV INLRY BROY = A s 2 A MILT
DIEREFS £,
n BT ¥ RNDOEE~DS

n — T A NT A—%  (Wait Trigger. Repeat, Event Jump To 35 & U Go To)

46 AWG5000 ) —X DAy« RE—k »2—H -37=aFI



Edt *=a2—%FERT 5

[

B U U RFERMOTL A~ (Element Index = 1) M HIRIZEI TS VET, 727 L Event Jump
To & %3 Go To DIRENH 2L AT TS > TEITS N ET,

B AXNVPMELT, UFOEERYR—FEINET,
® HifE/ SRV Event Input =2 % 7 Z 2 S N HE 5
m Bif/ kLD Force Event 78 Z » BN S -4

m VE—hF -avR

EEBEREERL =212, fERLTE— U AT THE—RFRELTNA—RKDUzT « —F
VY EV TN 2T =T D2ODF—FRRHDET, 2O0DF—KDOEWIZOWTIL, A
VIAY e ~NVTEBBLTLIEE N,

AWG5000 > 1) =X 94w - RE—bk - 2—H - 7=aT7)L 47



Edit * =2 —%ERAT 5

=52 ADRE

48

YER LTy — v A fRET A0 a <2 N8 Edit A= 2—

WCHE SN TWET,

Clear. Clear 1Zi®IR S N/=T — X 2 4IHIL L £9, BEHOIEGRTL AL N2 7 VT FT5Z ENT
XFET, V—HUADEYVDT—ZIIT 7 FLERA,

Copy. Paste-Insert # & U Paste-Replace. 1 > 7= 13K DEF L ==L A |k

LT ae—=x

N—=ARNETHIZLENTEFES, VT R—FDOT—EZNRN—r 2 ADFRE L AL EICH AT
ITEE#Lx 5 kT, Paste-Insert Tik, O DOF—Z I 7 b L ET,

Cut B4EHI( —H 2 X+ E—F)

1 DFEZFIEHOHE R L Iz A2 R

1. Cut3 5L A MEFEEL £9,
E 0BT, Index T 5 2 MNkt4:
W0 E£9,

. Cut B L W Delete 1L A b
BALTLMTA EE AL

2, Bdit Ama—FIR T T v
7 Ama—b Cut &R F
j‘o

3. Cut BEfTIN, BYDOT—HIiZ
7 RLET,

1 . Delete TIEZ7 U v 7R —FK®D
FT—HIEDLY FEAN, Cut TIE
By NENTZT =BTV v T HR—
FizAnGNET

Ek

2% L T Cut =2 Delete S CT& £,

Sequence
Total Time : Os

Index No: 2 Running :

__

I

I
- i
2 960 Points
2

<

-
(/
g

Sequence
Total Time : 0s

Index No: 2 Running :

] I __

Sequence Contral Parameters...

Export Waveform To File..

Standard Waveform

Cut
Delete
Clear
Gopy
Insert..

Sequence

Total Time : Index No: 2 Running :

Empty Empty
QﬁI] Points

B VU AREORZE U FOFEMICOWTIR, AT A LT EBRL TLEE N,

AWG5000 > 1) —X 94wy + RA—bk - 2—H - 3=a7)L



Edit A=—2—%FHT 5

Set Waveform/Insert Waveform z {9 5
Sequence ¥V 4 & K U T DOE MR £ ITHANTE E7,

m  Set Waveform — iR L 72X % Sequence 7 4 > R U DIRE LIz B/VIZEy T 50 E7i3ts
ELTWE LB &AL 7,

= Insert Waveform — 4R L 724/ % Sequence 7 4 > K 7 DFRE L I-ALE AL £,
1. Sequence '7 P ]\\‘ ]7 b@?ﬁﬂé %% % Sequence
Bz FITA LWL ETH

TV ZLTHRy T T v - A
—a—%#/~L. Set Wave-

Total Timp =" = 1 Current:3
| Sequence Control Parameters...

Export Wawveform To File...

S A
form... 7213 Insert Waveform... Standard WaistRils VA
PIRINL £, o

Delete Empty
iflfi\ Edit }:1—75)%16 Z Clear
NoHOREIZLT 7 v ATE T, Copy

Insert Wawveform...

- Set Waveform...
- Paste - Insert
c"::‘iv Paste -Replace | —
2. Waveform List 7 4 > K 72U A B Woavcform X

h STV B DOIFERNFER S User Defined —n
NET, BEEHXEIIHEALL

W 2R L £,

3. OK%z7 U v /4% LEROES
A FTIAREITENE T,

W

(3: < i | >

o ok | [ Cancel | [ Heb

e~k

m Waveform List 7 ¢ > R 712U A R STV DI ZEIRL T, EHE Sequence 7 1 ' K VTR
FZy 7L Th, WEOEESHZ TR AD AR T,

AWG5000 ) —X A4y Y - RA—k - 2—H -3=aTF)L 49



Edit * =2 —%ERAT 5

Paste-Insert/Paste-Replace % £ A3 %

Waveform 7 ¢ > R £721% Sequence V 4 ' RV LT/ Vw7 « R—=RF DT —F & AEI1LEE
iz CTxET, LLTOHIEL, Waveform 7 « > K v TO Paste-Insert #{ER T,
1. Ch2 OPIEZEIRL £7°,

2. W=V NVEMHEHL T, 2 —#ipH
HETELET,

Chz:0v A512 Pts

3. Edit> Copy... Zi&RL T, ¥ A
Ty Ry ZAEERL, TA
TAhEVUUERTEL £,

4. OK%z 7 Vv 7 L Tat—&3T
Lij‘o

Copy

Item

Cal

() Selected

Fiange @
Qall

(* Between Cursorg

o =i [ od J (oo ]

5. Chl OWEETINL £,
6. Paste-Insert T A& fHEL £

A512 Pts

T
7. Edit £ = = —»> Paste-Insert % 52 _ —
ﬁ,jﬁj_é & R Ch 1 @{&ﬂéﬁ: = to_ ch1:0V Ch20V AOPts C1Pos: OPts cz2pos: |

L7eT—#MfAS L ET,

EVEk
m Paste-Insert ZFE(TTH L, HKOVDOT—ZITT 7 F ST,
m Paste-Replace #FE/TL TH, KV DOT =X T 7 b S EHA,

50 AWG5000 ) —X DAy« RE—k »2—H -37=aFI



Edit A= 2 —%ERAJ D

Rename Z /A9 %

Waveform List 7 « > R VIZEREINDEIEOLRI# LT T ET,

1. Waveform List 7 ¢ > K o T4 Hi
EEWRLIEWVEEZRINL, A
= =2— + N"—T Edit > Rename..
ZIN9 % & Rename ¥ 7 1
T edRmy 7 AEBFRRLET,

2. BUEDBIRAHRF RS NETS,
3. HLWEIEAZ AL £7

@
@

®

Z DD Edit X =2 —% ERAT S

Scale.Edit A==—® Scale Z{HEAL TTrF s « F—FZDIEEL-L 2O T, BEOIR

EMEFRFLIZEERSSEZLEADLD I LN TE T,

1. EEHA 77— /LD JF A (Origin) &
A—)v « T 7 JEERHETEE
T, A—)b 77 7 ZITHALIL
b FEHA,

2. TATLELUVITONTIL,
M=V EZRL TSN,

@

@

Hename

Change Wawe form MName

&3

| Rename: samplal 2
To | EEEm

Scale X
Vertical Scale
own: - [JZO0TO00VEE]
sede: [ 200
Item
® &ll Analog
O Selected
Range
of]
() Between Cursors
| ok | [ Cancel | [ Hep

AWG5000 > 1) =X 94w - RE—bk - 2—H - 7=aT7)L

51



Edit A= —%EAT D

Offset. Edit A ==—® Offset ZifiL C. 7F a7/ « F—ZDIRELIZL o IZHONWT, EF%Em
ZHTENTEET,

1. A7ty &, Voltage £7-1%
Normalized Value TR TETE £
To @ Walue

2. TAFLEL L IITONTIL, [ 1000000V
44 X—T SR TN,

Item

(%) 4ll Ainalog

@ () Selectad

Range
OF]

() Between Cursars

| ok || Cowed | [ He |

Invert. Edit A== —® Invert ZfiH L T, {HELZL v VDT —FERKEEESEDLZENTEET,

1. TATAEL Y PIZOVTIL, Invert ®
44 N=VEBRL TS, -~
It
Thus - F=2TEH, FITRAD P
Cal

BN~ AF AR £4, <—
jj . ?j‘_‘&wc“bi\ = — (0) Z)§/\/f @SE|ECth
(D) 2720 E£79,

Range

O

(+) Between Cursars

[ OF. l l LCancel l l Help

52 AWG5000 > 1) —X 94wy + RA—bk - 2—H - 3=a7)L
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Horizontal Shift/Rotate. Edit * = =.— Shift/Rotate ZfEl L T, FEEL /2L P OWET —# &K
S ENZ Shift 7213 Rotate (AW AL 7 b)) THZ EMNTEFET,

1. &— R (Shift 7= Rotate) % i3 - T—— 3
*R L SE —g’«o Mode —
2. Shift¥7-1% Rotateﬁ_ HlL v v %—f]\ (%) Shift Value
LET, 5000 Pis|=
jj ‘a_ () Rotate D| = SE
3. Linear % 7= 1% Quadratic O ## [E] )7 ¥ @
%E&ETR L/ i ﬁ—o @ Irterpolation
4. TATLEL U IVITHONTIE, O Lz
44 ‘/\O‘—?\/\\%}}gﬁﬁl_/(< fiél/\o OQuadratic
Itermn
® 2l
@ () Selected
Fiange
(OF]
() Between Cursors
[ ak. ] [ LCancel ] ’ Help

EVR

m Horizontal Rotate {%, KIE VKL N ENDELEEIC., HIBERORE DI EROFEIEOE
SEEL A DR DM MN o TN DEINE O N B R T HT-OIEH I N ET,

m Horizontal Shift/Rotate (77 2 « T—XZ B I ON~—FlT@EH I ET,

Set High/Low. Edit A == —® Set High/Low Zfi]L T, fEL L Y D~—H « T—F &/ A

FERFe—ICERETDHIENTEET,

1. ngh F7-1% Low %%?ﬁb jﬁj_o Set High / Low ﬁl

2. TATLLLUINTHOWVWTIT, @ Value
44/\0_:‘)%7;5;%\.\E\L‘/C<fiéb\o @High

() Low

Ibern

() Al M arkers

@ (*) Selected

Fange

ol

(*) Between Curgors

I ok ] [ Cancel ] [ Help

AWG5000 > 1) =X 94w - RE—bk - 2—H - 7=aT7)L
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PRBS. WIEDFREL 7oL VD PRBS NZ — U ZEEMA D LN TEET,

1. PRBS /X% — @I L £7°, WEES x|
2. Mark Density Z %R L £, @ Pattern
3. Wistyv /A7 xBETEET, [T+ e e e s
4. 77/])%AEV:/T‘/\\GC‘/)I/\¢CVJ:\ bdark Diensit
44 R=VEBML TS0, @ ! [Jinvert
148
(44 @
(2142 (Mormal)
(C)asd
(748
ltem
ONI Markers
@Selected
@ Ranga
OAII
@Between Cursors
[ Ok ] [ Cancel ] [ Help

Set Pattern. ~— % « T — X DIRELZHIKET VXL « XA~ THOH L Z ENTEFET,

1. /\o&‘—\/%@j‘%)\ﬁﬁéb\ if: Set Pattern §|
ETFF AR « 77 AN FERIA —
Bl bhekaT. @

Tatal Points: 19
BET&E /7 — 2 DR KREIL Cursor Position: i
1000 T,
2. TATLELUIIZONTIL,

44 R—=TU BB TLTE I, ltem
HELD T A T L)Y Set Pattern D © Al Matkers
Z—/2y b ELTHRESNEZSS O Selected

E. TRTOT AT ACAL 7 — @
ZRHEDIAENET, iz

(OF:1

() Between Cursors

[ Ok l ’ LCanecel ] ’ Help

54 AWG5000 > 1) —X 94wy + RA—bk - 2—H - 3=a7)L
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Clock Pattern. ~—% « T — X OREL/-MEEZ 1010 D70y 7 « REY— THODHZ LR TEE
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